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Introduction
This guide explains how to administer Bluebeam® Revu® once you’ve completed your Enterprise installation.

The included information covers topics such as Bluebeam Studio, firewall and proxy settings, using Revu with 
document management systems, as well as Revu settings and preferences, with the goal of giving IT 
administrators the knowledge, self-sufficiency, and freedom to manage and troubleshoot all aspects of Revu 
across your organization and the globe.

Note: Complete instructions for deploying Revu in your organization can be found in the Bluebeam Revu 
Enterprise Installation Guide, which can be found on our Enterprise Installation page.

Please refer to the Bluebeam Support site for information about Bluebeam Studio Enterprise or Studio Prime.

Customers looking for information about installing and using Revu in a virtual environment should refer to 
Revu in a Citrix Environment.

http://support.bluebeam.com/help/
http://support.bluebeam.com/help/
http://support.bluebeam.com/enterprise-installation/
http://support.bluebeam.com/
http://studioenterprisesupport.bluebeam.com/
http://support.bluebeam.com/help/
http://support.bluebeam.com/help/
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Revu Licensing
Bluebeam offers three different Revu licensing options (Perpetual, Open, and Enterprise) as described below. 
However, software registration and activation is usually performed as part of the Enterprise Installation 
process.

Perpetual Licensing
Bluebeam Perpetual Licensing registers Revu Standard, CAD and eXtreme® on a per workstation basis using a 
serial number and product key, which is sent to our licensing server during the initial registration.

Registering Revu
Before you begin the registration process, make sure you have the correct serial number and product key for 
the Revu version and edition you’ve deployed. This was sent from registration@bluebeamops.com. If you’re 
unable to locate it, please contact us to request another copy of your License Certificate.

Online Registration
Although registration and activation usually takes place during either an Enterprise or manual installation, you 
can manually register an individual Revu installation by following the steps listed below:

Note: During this process, all Revu versions will connect to https://activation.bluebeam.com. Revu 2015.5 and 
2015.6 connect to https://bluebeam-us-east.accesscontrol.windows.net, while Revu 2016 and above will 
connect to https://login.microsoftonline.com/. If you’re registration fails, please make sure these are set as 
trusted locations in your firewall.

 Open Revu, and click Help > Register.
 When the Bluebeam Registration dialog opens, enter 

the serial number and product key.
Note: The product key is case sensitive, and doesn’t include the letter 
‘O’.

 Click Register.

Manual Registration
If you’re connected to the internet from behind a firewall, or the online 
registration fails:

 Open the Registration dialog as described above.
 Enter the serial number and product key, and then click Register.
 When prompted, click Get Authorization Code Manually, enter the computer name, and click 

Continue.
 Click the hyperlink at the top of the dialog. A web browser opens displaying the Revu Activation 

page.
 Review the information and click Get Authorization Code. The code appears on the next page.
 Enter the code into the Manual Authorization dialog and click Authorize.

Note: If you’re unable to connect to the internet, follow steps 1 through 3, then go to 
https://activation.bluebeam.com on another machine that is able to connect and enter the Serial Number, 
Product Key, Security ID and Computer Name. After you’ve done this, you can go back to the original machine 
and enter the Authorization code. Please contact us if the registration still fails.

mailto:registration@bluebeamops.com
http://support.bluebeam.com/contact/
http://support.bluebeam.com/help/
http://support.bluebeam.com/articles/bluebeam-revu-2016-installation-guide/
https://activation.bluebeam.com/
https://bluebeam-us-east.accesscontrol.windows.net/
https://login.microsoftonline.com/
https://activation.bluebeam.com/
https://activation.bluebeam.com/
http://www.bluebeam.com/us/contact/
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Managing Your Perpetual Licenses
To help you keep track of your license usage, we offer a License Key Lookup 
page where you can generate a report of currently registered machines, and 
determine the number of available seats. All you have to do is enter the serial 
number, product key, and the email address listed on the license, then click 
Get Info.

If you find a machine listed that shouldn’t be registered, you can either 
unregister it via the Revu Help menu (Help > Unregister), or uninstall the 
software. In the case of a lost, stolen, or re-imaged computer, you can contact 
us to have it unregistered.

Migrating a Perpetual License to a New Computer
If you need to use a Revu license on a different machine, follow the instructions in our FAQ on Transferring 
Your Bluebeam License to a New Computer.

Note: You’ll need the serial number and product key listed in the license certificate, which was originally sent 
to you from registration@bluebeamops.com.

If you’ve lost this information, you can contact us to request a new copy of the License Certificate. When doing 
so, be sure to include the version number, your name, company name, email address, and the phone number 
where you can be reached.

You can find the serial number by clicking About in the Help menu (Help > About). A new dialog will open, 
displaying the serial number in the upper-left, below the title and version number.

Open Licensing
The Revu Open Licensing model is a cloud-based solution which lets customers using Revu eXtreme 2015.5 
and above share a common pool of licenses across multiple users and devices. There aren’t any special 
hardware or resource requirements other than a standard internet connection to communicate with the 
Bluebeam License Hub, where their licenses are hosted and managed.

This licensing method is compatible with all Revu eXtreme versions (2015.5 and above), which means you can 
gradually upgrade your Revu installations in stages. 

Communications between the computer and licensing server are conducted over an HTTPS connection, and 
include the Revu version number, serial number, product key, computer ID (the security ID), and the username.

Obtaining a License
Whenever Revu launches, it checks the server for an available seat on the license. If it finds one, the software 
will finish opening and occupy the seat. But if not, a message will notify you and tell you to contact the Open 
License Administrator.

Note: Revu contacts the licensing server every 20 minutes to make sure the seat is still occupied, but the 
system will release the license after 3 failed attempts (one hour). In this way, we ensure that the license is made 
available to another user. 

To ensure that no one loses any unsaved work, the first user of the seat in question will be able save their work. 
However, Revu will check for an available seat if they close and reopen the application.

http://www.bluebeam.com/us/license/reglookup.asp
http://www.bluebeam.com/us/license/reglookup.asp
http://support.bluebeam.com/contact/
http://support.bluebeam.com/contact/
http://support.bluebeam.com/articles/transferring-your-bluebeam-license-to-a-new-computer/
http://support.bluebeam.com/articles/transferring-your-bluebeam-license-to-a-new-computer/
http://support.bluebeam.com/contact/
https://www.bluebeam.com/us/products/revu/open-licensing.asp
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Offline Mode
If a user is in a situation where an internet connection isn’t available, a previously Open-Licensed copy of Revu 
will successfully launch for 3 days before it’s required to obtain a license from the server. 

Managing your Open License
To help you manage your licenses, we’ve created the Bluebeam Gateway. Once you’ve created an account, 
you can perform various tasks with your licenses such as tracking, reporting, revoking, and reissuing. You can 
find detailed instructions for using this web portal in the Bluebeam Gateway User Guide. 

Enterprise Licensing
Our Enterprise Licensing solution is another cloud-based option that automatically tracks your Revu 
installations and releases the seats from computers that aren’t actively running the application, while providing 
a 5% overage of available seats to minimize the possibility of running out of seats on the license.

The way this works is that once a Revu installation is registered to an Enterprise License, it continues to use a 
seat until the host computer has been inactive and hasn’t contacted the licensing server for 15 days. At that 
point, the system will release the license so it can be used by another machine. However, if the inactive 
computer contacts the server again, the license is restored – even if the 5% license overage has been 
exceeded. This is done as a courtesy so that the end-user can continue working in Revu without interruption.

Note: You will need to purchase additional licenses if the overage has been exceeded.

The benefit of this licensing model is that you don’t need to contact Bluebeam to release a license if, for 
example, a computer experiences a crash, is stolen, or re-formatted.

Technical Details
A computer with an Enterprise-licensed installation will contact the licensing server one hour after a “qualifying 
event” has occurred, and won’t do so again for at least another hour afterward.

Examples of qualifying events include:

 The BBAdminUser process launching whenever the machine starts up.
 The launch of a Bluebeam application such as Revu, the Bluebeam Stapler, or Bluebeam 

Administrator.
 PDF creation using the Bluebeam PDF printer, or the Bluebeam plugin within a supported third 

party program such as Microsoft® Office® or AutoCAD®.
Communications between the computer and licensing server are conducted over an HTTPS connection, and 
include the Revu version number, serial number, product key, and computer ID (the security ID).

Managing your Enterprise License
Enterprise License management is done through the Bluebeam Gateway. Detailed instructions for using this 
web portal can be found in the Bluebeam Gateway User Guide, and as with an Open License, you can perform 
various tasks related to licenses such as tracking, reporting, revoking, and reissuing (Revu 2015.5 and above).

Enterprise Licensing Agreement
Please refer to the Bluebeam Revu Enterprise License Agreement for usage guidelines and limitations.

https://portal.bluebeam.com/
http://support.bluebeam.com/articles/bluebeam-gateway-user-guide/
http://support.bluebeam.com/articles/bluebeam-gateway-user-guide/
https://www.bluebeam.com/private/documents/Bluebeam_Revu_Enterprise_License_Agreement_2016.pdf
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Switching from a Perpetual License to Enterprise or Open Licensing
If you need to change your Revu licensing scheme from Perpetual to Enterprise or Open Licensing, you can do 
so using the registration script shown below. This automatically unregisters and re-registers your software, so 
long as there are available seats on the new license.

Note: If you’re changing to Enterprise licensing, the version and edition of the installed software must match 
what’s listed on the new license. For example, a license for Revu 2016 Standard will only register machines 
running that version and edition of the software.

Open Licensing supports Revu eXtreme 2015.5 and above. With this in mind, Open licenses use the same 
serial number for all installations but a different product key for each major version number. In other words, if 
you have installations of Revu eXtreme 2015.5 and eXtreme 2016 in your organization, you’ll see a single serial 
number with two different product keys listed in the Bluebeam Gateway.

This script consists of a call to the Bluebeam Administrator, a switch that registers the software using the new 
license, as well as an optional delayed authorization switch for Enterprise Licenses.

Note: Delayed Authorization doesn’t register Revu until the first time a user executes a save operation in the 
software.

Open licenses do not require Delayed Authorization as the machine checks for an available license every time 
Revu is launched.

When executing the script, please be aware of the following:

 The whole script must be entered on a single line.
 The [ ] and < > should not be included.
 The product key is case sensitive.
 The version number used must match what’s installed on the machines.

Sample Script:

To call the Bluebeam Administrator you would use:

%ProgramFiles%\Bluebeam Software\Bluebeam Revu\<RevuVersion>\Pushbutton PDF\PbMngr5.exe

To use the register switch, you would type the register command along with your serial number and product 
key as shown below:

/register [<version> <serial number> <product key>]

The combination of the two is typed on a single line as follows:

"%ProgramFiles%\Bluebeam Software\Bluebeam Revu\<RevuVersion>\Pushbutton PDF\PbMngr5.exe" 
/register 16 1234567 ABCDE-5FGHIJK

If you want to utilize Delayed Authorization, add the ‘NoAuth” command to the end of the script:

"%ProgramFiles%\Bluebeam Software\Bluebeam Revu\<RevuVersion>\Pushbutton PDF\PbMngr5.exe" 
/register 16 1234567 ABCDE-5FGHIJK NoAuth

http://support.bluebeam.com/articles/bluebeam-gateway-user-guide
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Licensing and Computer Names
In this section, we’re going to cover a couple of details about registering Revu installations on new or re-
imaged machines.

 If your new machines are all based on a common disk image, or are part of a Virtual Desktop 
environment, you’ll need to change the machine name before attempting to register Revu. If this 
isn’t done, you’ll be in a situation where you’re trying to register Revu on multiple instances of the 
same computer, regardless of IP or MAC Address.

 If you’re re-imaging, or installing a new system drive in a computer without changing its original 
machine-name, our license systems will “view” it as the same computer, as if nothing had 
changed at all.

Renaming a Registered Machine
There may be a time when you’ll want or need to rename an existing machine that Revu is already installed on. 
In this instance, you’ll need to “let the licensing system know” about the name change and update the 
registration.

Although you could go to the help menu and unregister the machine (Help > Unregister), change its name, 
and re-register it, a quicker way to update the registration would be to change the machine name and then 
use the following script:

"%ProgramFiles%\Bluebeam Software\Bluebeam Revu\Pushbutton PDF\PbMngr5.exe" /update

You can run this on individual computers using a batch file, or push it to the machines in question using 
deployment tools or login script. In either case the script calls up the Bluebeam Administrator (Pbmgr5.exe) 
and tells it to update the registration server with the new machine name.

Note: The Bluebeam Administrator must be able to run with elevated privileges, and your firewall and proxy 
server should not prevent it from connecting to the internet.

Virtual Environment Licensing
Please refer to Revu in a Citrix Environment for licensing information within virtual environments.

http://support.bluebeam.com/help/
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Bluebeam Studio

The Basics
Bluebeam Studio™ is our cloud-based collaboration platform that’s included in all versions and editions of 
Revu, and is designed to help teams and organizations manage work projects anywhere, at any time, from a 
Windows or Mac OS desktop, Windows tablet, or iPad.

All files and markups are stored in a password-protected and encrypted combination of Amazon’s Simple 
Storage Service (S3) and a Microsoft SQL Server Database.

Users can create and join Studio Sessions and Studio Projects, then upload PDFs and other file types, allowing 
them to collaborate with their partners in real time.

Studio Sessions
Bluebeam Sessions supports Revu 8.5.0 and above, combining the best of 
real time document-based online collaboration with cloud storage. Simply 
upload your PDFs to a Studio Session, and then invite attendees from around 
the world to view and add markups to the same PDFs in real-time, or on their 
own time. All activity is tracked in a record that conveniently links back to the 
PDFs, and you can even create reports to archive or share with your team.

Studio Projects
Bluebeam Studio Projects supports Revu 10.0.0 and above, and acts as a 
simple cloud-based document management system, giving users the 
flexibility to upload PDFs and any other file types along with extra space for 
sharing and storing files.

Along with this, Studio Project hosts can invite an unlimited number of 
attendees, and set permissions for an individual attendee or groups of 
attendees. These delegated permissions control an attendee’s ability to add or delete files, create Sessions 
from a Project, invite other attendees, and even manage their permissions.

Studio Platforms
Bluebeam offers three different versions of Bluebeam Studio. Although each provides the same user 
experience with access to Studio Sessions and Projects, there are differences based on the Administrative 
controls within each platform.

Bluebeam Studio
Bluebeam Studio is the free version included with every copy of Bluebeam Revu. All documents, user 
comments, and markups are housed on the Amazon AWS cloud.

Studio Prime
Studio Prime is our subscription-based cloud solution, offering all Bluebeam Studio features, plus 
administrative functions, and access to the Bluebeam Studio API for integrating external applications.

Studio Enterprise
Studio Enterprise lets customers host and manage Bluebeam Studio on their own servers, behind 
their firewall. This option lets you control security and access, and monitor all activity.

http://www.bluebeam.com/us/products/studio/
http://support.bluebeam.com/articles/bluebeam-studio-security-and-disaster-recovery/
http://support.bluebeam.com/articles/bluebeam-studio-security-and-disaster-recovery/
http://www.bluebeam.com/us/products/studio/
http://www.bluebeam.com/us/products/studio-prime/
http://www.bluebeam.com/us/products/studio-prime/faq.asp
http://www.bluebeam.com/us/products/studio-enterprise/faq.asp
http://www.bluebeam.com/us/products/studio-enterprise/faq.asp
http://www.bluebeam.com/us/products/studio-enterprise/faq.asp
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Note: Please refer to the Bluebeam Support site for additional technical information about Bluebeam Studio 
Enterprise or Studio Prime.

Session and Project Lifecycles
One of the questions you’re likely to be asked is how long Sessions and Projects will remain on the server 
before being automatically deleted.

Sessions
The following will happen if a Studio Session is manually set to Archive in the Studio Portal or left inactive for 
an extended period of time:

 After 80 days, a notification email is sent to 
the Host saying the Session will be archived.

 After 90 days, the Session will be archived.
 After 170 days, the Host will receive another 

email saying the Session will be deleted in 
10 days.

 After 180 days, the Session will be deleted 
permanently. It cannot be recovered at this 
point.

Note: This information applies to inactive Sessions which have not been Finished (Finalized).

If the email doesn’t arrive in the host’s inbox, please check their spam or junk email folder, and make sure that 
studio@bluebeamops.com is on the approved list of senders

Organizations using Studio Enterprise can change the durations listed above. Please refer to the Studio 
Enterprise Guide for further information.

Projects
Unlike Sessions, Studio Projects are never marked for archival or deletion, and can only be deleted by the 
Project owner or a user who was given Full Control.

Studio Security and Disaster Recovery
From time to time, we receive questions from Bluebeam Studio users about the safety of the files they're 
uploading to Bluebeam Studio. These concerns usually revolve around the overall level of document and 
system security, as well as what would happen in the event of an infrastructure failure. With this in mind, we’ve 
posted a Bluebeam Security and Disaster Recover FAQ on our website to help address these concerns.

Note: These measures apply to Bluebeam Studio and Studio Prime. Since Studio Enterprise is hosted behind 
the customer firewall, it is up to their IT department to design, implement, and maintain their own security and 
disaster recovery protocols. However, they can use the information in this FAQ as a possible starting point for 
creating their own protocols.

http://support.bluebeam.com/
http://studioenterprisesupport.bluebeam.com/
http://studioenterprisesupport.bluebeam.com/
http://support.bluebeam.com/help/
http://support.bluebeam.com/articles/learning-about-bluebeam-studio/
http://support.bluebeam.com/help/
http://support.bluebeam.com/help/
http://support.bluebeam.com/online-help/revu2015/Content/RevuHelp/00%2520-%2520Command%2520Bar/06%2520-%2520Studio/Studio_Start_a_Project%2520-%2520T.htm
http://support.bluebeam.com/online-help/revu2015/Content/RevuHelp/00%2520-%2520Command%2520Bar/06%2520-%2520Studio/Studio_Start_a_Project%2520-%2520T.htm
http://support.bluebeam.com/online-help/revu2015/Content/RevuHelp/00%2520-%2520Command%2520Bar/06%2520-%2520Studio/Studio_Permissions_Projects.htm
http://support.bluebeam.com/articles/bluebeam-studio-security-and-disaster-recovery/
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Connecting to Bluebeam Studio
The first thing to note is there are no inbound connection requests to the Revu and Vu software from Studio, 
and connections to the Studio Server are always initiated by the client machine.

Authentication and security are handled by Secure 
Socket Layer (SSL) protocols and HMAC-SHA256 
cryptography encryption, in conjunction with digital 
certificates issued by a third-party Certificate 
Authority (CA).

Once a connection is established, files, markups and 
other rich data are transmitted via HTTPS, using a 
mixture of Web Service calls and a TCP/UDP 
protocol through SSL Port 443.

* For Vu and Revu versions 12.1 and below

Firewall Requirements

Revu and Vu 12.5 and Above
Bluebeam Revu and Vu 12.5 and above communicate with the Studio Server on Amazon Web Services (AWS) 
over HTTPS Port 443, you’ll need to set your firewall to grant access to the following domains and ports:

 studio.bluebeam.com:443
 *.amazonaws.com:443

Revu and Vu 12.1 and Below
For Revu and Vu 12.1 and below you will need to configure your firewall to grant access to:

 studio.bluebeam.com:7398
 studio.bluebeam.com:443
 *.amazonaws.com:443

Note: Revu and Vu 12.1 and below also communicate with Studio via TCP/UDP Protocols; 
studio.bluebeam.com:7398 needs to be open for these clients. 

Be sure to enable both TCP and UDP on port 7398.

Bluebeam and Bluebeam Studio Related Email Domains
Your users will receive emails from Bluebeam or the Bluebeam Studio system, which may include responses to 
support requests, licensing details, invitations to Studio Sessions or Projects,  Studio activity notifications, or 
validation requests for new Studio accounts.

These emails will be sent from one of the domains listed below, which need to be white-listed in order for 
these messages to be received:

 @bluebeam.com
 @bluebeam-support.com
 @Bluebeamops.com

http://support.bluebeam.com/online-help/revu2015/Default.htm
http://support.bluebeam.com/online-help/revu2015/Default.htm
http://support.bluebeam.com/online-help/revu2015/Default.htm
http://support.bluebeam.com/articles/how-do-i-create-a-bluebeam-studio-account-in-revu-or-vu/


10

Bluebeam Studio Portal
To help users manage various aspects of their Bluebeam Studio presence, we’ve created the Bluebeam Studio 
Portal. After they’ve logged in with their Studio account credentials, they’ll be able to perform the following 
tasks:

 Manage their Studio Profile
 Password changes
 Email address changes
 View a list of Sessions they’ve created
 Reassign ownership of their Sessions
 View a list documents in their Sessions
 Recover their deleted Session documents
 View lists of attendees for their Sessions

Note: Additional information about Bluebeam Studio can be found on our Support site, as wells as the Revu, 
Revu Mac, and Revu iPad manuals.

Troubleshooting
If your users run into issues with, or have questions about using Bluebeam Studio, we have numerous FAQ 
articles on our Support site, offering solutions for common problems such as:

 Creating a Studio account using Revu or Vu, Revu Mac, or Revu or Vu iPad
 Using Bluebeam Vu or Vu iPad to work in Bluebeam Studio
 File upload or download failures
 Inability to receive Studio related emails
 Configuring Studio Notifications and Alerts in Revu and Revu Mac
 Setting Studio Project folder permissions in Revu and Revu Mac

Additional information can be found in the Revu, Revu Mac, and Rev iPad manuals, as well as the tutorial 
videos found on our Bluebeam University website.

Note: Customers looking for additional, specific information about Studio Enterprise or Studio Prime should 
refer to the Bluebeam Studio Enterprise or Studio Prime section of the Support site.

https://studio.bluebeam.com/
https://studio.bluebeam.com/
http://support.bluebeam.com/categories/studio/
http://support.bluebeam.com/help/
http://support.bluebeam.com/mac/
http://support.bluebeam.com/ipad/
http://support.bluebeam.com/categories/studio/
http://support.bluebeam.com/categories/studio/
http://support.bluebeam.com/
http://support.bluebeam.com/articles/files-fail-to-upload-or-download-in-studio-because-the-computer-clock-is-incorrect/
http://support.bluebeam.com/articles/how-do-i-create-a-bluebeam-studio-account-in-revu-mac/
http://support.bluebeam.com/articles/how-do-i-create-a-bluebeam-studio-account-in-revu-or-vu-ipad/
http://support.bluebeam.com/articles/using-bluebeam-vu-to-access-bluebeam-studio/
http://support.bluebeam.com/articles/files-fail-to-upload-or-download-in-studio-because-the-computer-clock-is-incorrect/
http://support.bluebeam.com/articles/studio-emails-arent-being-received/
http://support.bluebeam.com/articles/bluebeam-studio-notifications-and-alerts/
http://support.bluebeam.com/articles/bluebeam-studio-notifications-and-alerts-mac/
http://support.bluebeam.com/articles/setting-revu-2015-studio-project-folder-permissions/
http://support.bluebeam.com/articles/setting-studio-project-folder-permissions-mac/
http://support.bluebeam.com/help/
http://support.bluebeam.com/mac/
http://support.bluebeam.com/ipad/
http://www.bluebeam.com/us/bluebeam-university/training-materials/
http://www.bluebeam.com/us/bluebeam-university/training-materials/
http://www.bluebeam.com/us/bluebeam-university/
http://studioenterprisesupport.bluebeam.com/
http://support.bluebeam.com/help/
http://support.bluebeam.com/
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The Bluebeam Administrator
The Bluebeam Administrator lets you configure and control Revu using the functions and features on the 
various Tabs as described below:

Note: Information about features that aren’t covered in the chapter can be found in the Bluebeam 
Administrator Help Guide.

Plugins Tab
This displays a list of installed applications that are supported by our 
PDF plugin which are detected by the “Bluebeam Admin User.exe” 
that launches when the client machine starts up.

All Revu editions will list the plugins for Microsoft Office (Word, Excel, 
Power Point, and Outlook), but the plugins for AutoCAD, Revit, 
SolidWorks, Navisworks, and SketchUp Pro only appear on machines 
running Revu CAD or eXtreme.

The exception to this is if a 30-day trial of Revu Standard is installed on 
a machine that already has a compatible CAD application installed. In 
this instance, the corresponding plugins will appear in the list, and they can be enabled post installation. At 
the end of the trial period, the user will see a trial expiration message when attempting to use any of the 
plugins.

Note: The Plugins tab will list all supported versions of any given CAD application that’s installed on the 
machine.

Revu 2017 Side-By-Side Installation
Revu 2017 can be installed and run side-by-side with Revu 2016 and above, which lets your end-users run Revu 
2017 as a fully-functional 30-day trial. This lets users evaluate Revu 2017 while your organization decides 
whether or not it’s time to upgrade.

When Revu is installed in this state, the plugins tab will list the compatible third-party software for each plugin 
version as shown in the screenshot above.

Note: All plugin activations and deactivations must be done in the 2017 version of the Bluebeam 
Administrator, if you are running side-by-side installations of Revu.

Enabling a Plugin
You can find more information about troubleshooting plugin issues on our Support page, but if a plugin is 
missing within a supported application, you can enable it by following these steps listed:

Note: If you’re running a side-by-side installation with Revu 2017, all changes must be made in the 2017 
Bluebeam Administrator. 

 Close the application
Click Start > All Programs > Bluebeam Software > Bluebeam Administrator.

In Windows 10 and 8.1, click or press Start  and type Bluebeam Administrator.

-Or-
Go to Help > Administrator in Revu.

 Click the Plugins tab.

http://support.bluebeam.com/online-help/bluebeam-administrator/Default.htm
http://support.bluebeam.com/online-help/bluebeam-administrator/Default.htm
http://support.bluebeam.com/articles/bluebeam-revu-compatibility-chart/
http://support.bluebeam.com/articles/bluebeam-revu-compatibility-chart/
http://support.bluebeam.com/categories/plugins/
http://support.bluebeam.com/articles/bluebeam-revu-compatibility-chart/
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 Click the check box next to the name of the program.
 Click OK.
 Reopen the application.

Net Configuration Tab (Net Config)
This is where you can determine the location of various Revu settings 
and assets. They can remain in the default local folders listed in the 
Unmanaged section, or they can be accessed from a centralized server 
location which you can set in the Managed Net Configuration section. 
However, you can also configure Revu to use a combination of local and 
network locations based on folder paths you define in the Unmanaged 
section.

Unmanaged Net Configurations
In a typical Revu installation, the Unmanaged option is enabled by 
default. In this instance, the assets and settings are located in various 
locations within the user’s Windows profile under C:\ProgramData as 
shown in the screenshot.

Managed Net Configuration
To configure your Revu installations to access all settings and assets from a centralized server location:

1. Select a computer to use as a “staging” machine, and copy any 
custom settings or assets into their corresponding default 
locations that are listed when the Unmanaged option is 
enabled. Refer to the screenshot of the Unmanaged settings 
above.

You can easily open the default folder locations by double-
clicking on their corresponding folder paths.

2. When you’ve finished copying the items, enable the Managed 
Net Configuration option. 

A dialog will open, where you can either browse to an existing 
network folder you want to use as the centralized location, or 
create a new network folder.

3. In either case, select the folder and click 
Select Folder.

When the Copy All Files dialog opens 
click one of the following choices: 

Copy All, which creates folders for the 
asset type or setting in the server 
location, and copies everything to the 
correct location.

Merge, which takes all locally defined 
settings and resources and merges them 
with any existing items in the shared 
location.
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No Copy, which points to the network folder, but does not copy or integrate anything into the folder.

Once the operation has completed, the Net Config tab will display 
the locations of all assets and settings.

Note: If you want to prevent your end-users from making changes to 
the centralized network folder, you can set the folder permissions to 
“Read Only.”

Centralizing Selected Assets or Settings
If you only need to centralize certain items, for example, just your 
custom stamps, you can do so by following the steps listed below:

1. Select a computer to use as a “staging” machine, go to 
the Net Config tab in the Bluebeam Administrator, and 
make sure the Unmanaged option is enabled

2. Open the default Stamps folder by double-clicking the folder path, copy your custom stamps into 
it, and then close the folder.

A dialog will open where you can either browse to an existing network folder you want to use as 
the centralized location, or create a new network folder.

3. Select the folder and click Select Folder.
4. When the Copy All Files dialog opens click one of the following choices: 

Copy All, which creates folders for the asset type or setting in the server location, and copies everything 
to the correct location.

Merge, which takes all locally defined settings and resources and merges them with any existing items in 
the shared location.

No Copy, which points to the network folder, but does not copy or integrate anything into the folder.

Now all of your Revu assets and settings – with the exception of your stamps – will still reside in their default 
locations.

Affected Registry Keys
The following seven registry keys are altered whenever you make changes in the Net Config tab:

Note: The folder paths shown below are for demonstration purposes only.

[HKEY_CURRENT_USER\Software\Bluebeam Software\<RevuVersion>\Pushbutton PDF]

"ManageNetConfig"="1"

"ManageNetConfigPath"="U:\\netconfig\\"

[HKEY_CURRENT_USER\Software\Bluebeam Software\<RevuVersion>\Brewery\V45]

"PageSizeConfigFile"="U:\\netconfig\\PtrPageSizes\\"

[HKEY_CURRENT_USER\Software\Bluebeam Software\<RevuVersion>\Pushbutton PDF\AutoCAD]

"PC3Path"="U:\\netconfig\\PC3"

[HKEY_CURRENT_USER\Software\Bluebeam Software\<RevuVersion>\Pushbutton PDF\Email]

"TemplateFolder"="U:\\netconfig\\E-mail\\"
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[HKEY_CURRENT_USER\Software\Bluebeam Software\<RevuVersion>\Pushbutton PDF\FTP]

"TemplateFolder"="U:\\netconfig\\FTP\\"

[HKEY_CURRENT_USER\Software\Bluebeam Software\<RevuVersion>\Pushbutton PDF\TextStampEx]

"TemplateFolder"="U:\\netconfig\\Stamps\\"

[HKEY_CURRENT_USER\Software\Bluebeam Software\<RevuVersion>\Pushbutton PDF\PageSetup]

"ConfigFolder"="U:\\netconfig\\Page Setup\\"

Deploying a Managed Configuration
The Bluebeam Administrator creates a registry file named Netcfg.reg which contains all affected registry keys. 
This file is located in the root of the managed folder (U:\netconfig in the preceding example), and it can be 
distributed as part of an MSI deployment as described in the Revu Enterprise Installation Guide.

You can deploy this registry file to the individual workstations to quickly apply the managed configuration. 

When distributing a Managed Net Configuration as part of an MSI deployment, the changes will not take 
effect until the client machine is restarted. However, a restart isn’t required when manually configuring an 
individual machine.

http://support.bluebeam.com/help/
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Printer Tab
This tab is divided into four sections (Printer Options, Printer, Port Monitor, and Image Resolutions) which offer 
features and functions for controlling and reinstalling the Bluebeam PDF printer.

Printer Options
These options determine what happens during and after a PDF is created using the PDF Printer or the Stapler. 

Prompt for File Name
When this option is enabled, a Save As dialog will appear, prompting the user to enter a file name, and if 
needed, choose a destination for the new PDF.

Delete Source PS File
This is disabled by default, but when enabled, the PostScript file a PDF is based on will be deleted once the 
document has been produced.

Open in Viewer
This setting determines whether or not the new PDF will be open in the default PDF application on the user’s 
machine.

Stapler Context Menu
When this is enabled, the Combine Files in Revu and Convert Files in 
Revu options will be available in the popup menu when the user right-
clicks on an applicable file on their desktop or in Windows Explorer.

Note: The user must have Administrative rights on the machine in order 
to change this setting.

Folder Options
Clicking this button opens the Folder Options dialog which lets you 
select the default location where new PDF documents produced using 
the Bluebeam Stapler will be saved. The available options are:

 Source Folder – This is the location of the 
original source file. 

 Last Saved Folder – This is the last folder that a 
new PDF was saved to.  

 Custom Projects Folder – This option lets you 
specify a default location of your own.

Image Resolutions
The Resolutions list shows the image 
resolutions that will appear in the Save As 
window for the Bluebeam PDF printer, 
Stapler, and Bluebeam Plug-ins.

http://support.bluebeam.com/articles/save-as-window-never-appears/
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Printer
In addition to displaying the printer name, driver, and printer port, the printer section is where you can select 
the default page size from the available list of pages sizes. You can also edit the page size list via the Manage 
Pages button as described below. 

Along with this, you can uninstall and reinstall the Bluebeam PDF printer using the Reinstall Printer button 
when troubleshooting performance issues.

Manage Pages
Clicking the Manage Pages button opens the Page Sizes dialog, where you can add, delete, or edit page sizes 
used by Revu, the PDF printer, Stapler, and plugins.

         

Note: These are the same page size settings (PrtPageSizes.xml) that are copied from their default location 
(%ProgramData%\Bluebeam Software\Bluebeam Revu\<RevuVersion>\Brewery\V45\Printer Support) when 
setting up a Managed Net Configuration.  

Reinstall Printer
If a user runs into an issue with either the Bluebeam PDF printer or 
Stapler, such as the Save As dialog not appearing when creating a 
PDF, one of the things you’ll need to do is use the Reinstall Printer 
button to reinstall the PDF Printer.

If this doesn’t work for some reason, you can also right-click the Reinstall 
printer button and select the Install Printer option.

Once the Bluebeam PDF printer has been installed, it’s a good idea to 
go into the Devices and Printers section of the Windows Control panel 
to make sure it’s been installed there.

Port Monitor
The Port Monitor is based on the BBPrint.exe process which runs on a per-user basis, and watches the user’s 
printer folder (C:\ProgramData\Bluebeam Software\Print Jobs\<username>) for files to process.

Note: Assuming that BBPrint.exe is enabled as a Startup item, it’s quite likely that the Port Monitor isn’t 
running if the Save As dialog never appears, or a user is otherwise unable to produce PDFs using the 
Bluebeam PDF printer or Stapler. In that case, the Port Monitor Status box will display “<n/a>”. You can 
restart the Port Monitor by following the instructions in the next section.

http://support.bluebeam.com/online-help/bluebeam-administrator/Default.htm
http://support.bluebeam.com/articles/save-as-window-never-appears/
http://support.bluebeam.com/articles/save-as-window-never-appears/
http://support.bluebeam.com/articles/save-as-window-never-appears/
http://support.bluebeam.com/articles/save-as-window-never-appears/
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Restarting the Port Monitor
If the Port Monitor Status shows as <n/a> or the Save As dialog is not being displayed while creating PDF, you 
will need to restart the Port Monitor. Once it’s running again, the Status should display as Responding, and 
BBPrint.exe should be listed as a running process in the Windows Task Manager. 

Troubleshooting the Bluebeam PDF Printer in a Citrix Environment
If you’re experiencing issues with the Bluebeam PDF printer while running Revu in a Citrix environment, please 
refer to Revu in a Citrix Environment for troubleshooting information.

Logging Tab
If you’re experiencing issues with Revu or its plugins, the Logging tab 
lets you enable the debugging feature and access the relevant logs, and 
if needed, email them to our Technical Support group.

You can also clear the existing log files, and empty the Bluebeam Temp 
folder, as described below.

Application Logs
These log files record the activities of the various Revu application 
components. You can open each log file by clicking its corresponding 
hyperlink.

Plugin Logs
This group of log files record the activities of any enabled plugins for supported applications. Each enabled 
plugin will have a corresponding hyperlink which you can click to open the log file.

Explore
This button opens the folder within the current Windows 
user profile where all the log files are stored.

Clear Logs
Clicking this button deletes the current 
collection of Revu log files, which are recreated 
once Revu or any enabled plugins are used.

Clean Temp
Click this button if you want or need to empty 
the Bluebeam Temp folder.

http://support.bluebeam.com/help/
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Email Logs to Support
This button is used for submitting your log files to our 
Technical Support group.

Note: Before sending in the log files, please click the 
Debugging On checkbox, and reproduce the issue. This 
creates new log entries that are specific to the issue.

Clicking it creates a zip file (logs.zip) containing the complete 
set of log files for all Revu components and plugins. This is 
attached to a new Outlook email, addressed to 
support@bluebeam.com.

If the new email doesn’t open for some reason, or you’re using a webmail account, you can click Explore and 
manually attach the logs.zip file to a new email addressed to support@bluebeam.com.

In either case, please include as much information as possible about the problem you’re experiencing.

Revu Tab
The Revu tab is divided into four sections (Bluebeam Revu, Web 
Browser, PDF Icon Color, and Language) which offer settings and 
functions for various aspects of Revu such as setting it as the default PDF 
application, selecting the default language, and more.

Bluebeam Revu
This section offers the following options and functions:

Use as Default PDF Viewer
Clicking this checkbox sets Revu as the default PDF application on the 
machine, and sets it as the PDF preview application used by the 
Windows Explorer and Outlook file preview panes.

Note: The user must have Administrative rights on the machine in order to change this setting.

64-bit/32-bit
These options are available when Revu is installed on machines are running the 64-bit version of Windows, 
because the Revu installer place both a 32 and 64-bit instance of Revu on the hard drive. Selecting either of 
these determines which one is launched when the Revu shortcut is double-clicked. However, because most 
machines are running a 64-bit operating system, the 64-bit option will be enabled by default. The 32-bit can be 
enabled as part of the troubleshooting process, if the user is experiencing issues with the software.

Quick Launch
When enabled, the Revu.exe process will launch in the background when Windows starts, so that the Revu 
interface opens faster. 

A small Revu icon will appear in the notifications area of the Windows Taskbar indicating that Quick Launch 
has been enabled.

Note: The user must have Administrative rights on the machine in order to change this setting.

Quick Launch should not be enabled on machines where the Document Management System Interface has 
been configured to work with ProjectWise because Revu won’t wait for the ProjectWise Explorer establish a 
connection to the relevant ProjectWise site.

mailto:support@bluebeam.com
http://support.bluebeam.com/online-help/revu2016-1/Default.htm
http://support.bluebeam.com/online-help/revu2016-1/Default.htm
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Reset Settings
Clicking this button automatically backs up your current Revu settings into a zip file 
located in C:\Users\{username}\AppData\Roaming\Bluebeam 
Software\Revu\{version-number}, and resets the software to the default state based 
the settings found in C:\Program Files\Common Files\Bluebeam 
Software\Bluebeam Revu\{Revu-version-number}\Revu.

Backup Settings
This button backs up your current Revu settings to a .zip file, and saves them to a 
location of your choice, which is useful when migrating them to another machine.

Note: Stamps and pinned items in the File Access tab are not backed up during this process.

Restore Settings
Clicking this button lets you backup and restore select Revu settings, which is an integral part of migrating 
Revu settings from one machine to another.

Web Browser

Display PDF in Internet Explorer
This setting enables and disables the Revu Internet Explorer plugin, which 
allows users to view PDF documents in a browser tab within Revu.

Note: The user must have Administrative rights on the machine in order to 
change this setting.

The browser will need to be reopened if you enable the plugin while IE is running.

Plugins for Firefox and Google Chrome are not available because they no longer support the Netscape Plugin 
Application Programming Interface (NPAPI), and have their own built-in PDF viewers.

PDF Icon Color
This lets you choose between the default blue Revu document icon and a red one.

Note: The user must have Administrative rights on the machine in order to change this 
setting.

Language
This dropdown menu is used when following the steps listed below to change the default language used by 
Revu:

Note: The user must have Administrative rights on the machine in order to change this setting.

 Select the desired language from the dropdown menu.
 Click Apply.
 Click Reset Settings. This applies the new language to customizable settings like profiles and tool 

sets.
Note: These features will be backed up and reset to their defaults, replacing any customizations made 
in the prior language. The prior settings in the old language can be restored, but to retain the new 
language it would be better to recreate the customizations.

 Click OK and reopen Revu. 

http://support.bluebeam.com/articles/how-to-back-up-your-revu-settings-stamps/
http://support.bluebeam.com/articles/how-to-back-up-your-revu-settings-stamps/
http://support.bluebeam.com/articles/how-to-back-up-your-revu-settings-stamps/
http://support.bluebeam.com/articles/bluebeam-plugin-doesnt-work-in-chrome-or-firefox/
http://support.bluebeam.com/articles/bluebeam-plugin-doesnt-work-in-chrome-or-firefox/
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AutoCAD Page Sizes Tab
This tab is available for Revu CAD and eXtreme editions on machines 
that also have a compatible AutoCAD product installed on them.

You can use the checkboxes to select the page sizes (ANSI, ARCH, or 
ISO) that you want to make available on the Page Setup tab of the 
AutoCAD plugin.

ANSI, ARCH, and ISO Checkboxes
As an alternative to clicking the individual checkboxes, you can use the 
ANSI, ARCH, and ISO checkbox to select or deselect whole groups of 
size types.

PDF Type
The PDF Type dropdown lets you decide which printer driver will be used when creating PDFs from AutoCAD. 
Your choices are either the default PDF driver or the Heidi (AutoCAD HDI) driver, which are explained below:

Printer
This option uses the Bluebeam PDF printer, which supports TrueType fonts for creating PDFs from AutoCAD 
with searchable text. In addition to offering better image quality, this driver also lets you add more Page Sizes 
and synchronize them across your network for use by all of your Revu CAD or eXtreme users.

Heidi
The Heidi option uses the AutoCAD HDI driver which doesn’t support TrueType fonts and “draws” non-
searchable text as Vector data. However, you can create custom Page Sizes and synchronize them across your 
network for use by all of your Revu CAD or eXtreme users.

Synchronizing Page Sizes Across Your Network

If you’d like to centralize your custom page sizes for all of your Revu CAD or eXtreme users, you can do so by 
following the steps listed below based on whether or not your organization used the Bluebeam PDF printer or 
the AutoCAD Heidi driver:

Synchronizing Page Sizes for the Bluebeam PDF Printer
1. Select a computer to use as a staging machine, and create your custom Page Sizes on it.
2. Once you’ve finished setting your custom Page Sizes, go to the Net Config tab. 
3. Click the  located to the right of the default folder path for the Printer Driver.

A dialog will open where you can either browse to an existing network folder you want to use as the 
centralized location, or create a new network folder.

4. Select the folder and click Select Folder.
5. When the Copy all Printer Page Size Files dialog opens, click Copy All. 

This copies the prtPages.xml file from the default location on the local drive to the network location, 
and the new folder path for the Printer Driver will be listed on the Net Config tab. 

6. Click Apply and OK.

http://support.bluebeam.com/articles/bluebeam-revu-compatibility-chart/
http://support.bluebeam.com/articles/autocad-creating-pdfs-with-searchable-text/
http://support.bluebeam.com/articles/autocad-creating-pdfs-with-searchable-text/
http://support.bluebeam.com/articles/creating-custom-page-sizes-for-autocad/
http://support.bluebeam.com/articles/raster-vector-and-text-whats-really-in-my-pdf/
http://support.bluebeam.com/articles/raster-vector-and-text-whats-really-in-my-pdf/
http://support.bluebeam.com/articles/creating-custom-page-sizes-for-autocad/
http://support.bluebeam.com/articles/creating-custom-page-sizes-for-autocad/
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Configuring Other Machines to Use the Centralized Page Sizes for the PDF Printer

This setting can be distributed to your other Revu CAD and eXtreme clients as part of an MSI deployment, or 
you can manually configure individual machines by following the steps listed below: 

Note: Centralized PC3 files cannot be used when the PDF Type is set to Printer. They can only be used when 
the Heidi driver is selected.

If this is distributed as part of an MSI deployment, the changes will not take effect until the client machine is 
restarted. A restart isn’t required when manually configuring an individual machine.

1. Open Bluebeam Administrator and go to the Net Config tab.
2. Click the  located to the right of default folder path for the Printer Driver.
3. When the Windows Explorer dialog opens, locate and click on the network folder which contains the 

prtPages.xml, and then click Select Folder.
4. When the Copy all Printer Page Size Files dialog opens, click No Copy.
5. Click Apply and OK.

Synchronizing Page Sizes for the Heidi Driver

1. Select a computer to use as a staging machine, and create your custom Page Sizes on it.

2. Click the Net Config tab, then double-click the folder path for the Heidi Driver.

A dialog will open where you can either browse to an existing network folder you want to use as the 
centralized location, or create a new network folder.

3. Select the folder and click Select Folder.

4. When the Copy all Bluebeam PC3 Files dialog opens, click Copy All. 

This copies the PC3 files from the default location on the local drive to the network location, and the 
new folder path for the Heidi Driver will be listed on the Net Config tab. 

5. Click Apply and OK.

Configuring Other Machines to Use the Centralized PC3 Files

This setting can be distributed to your other Revu CAD and eXtreme clients as part of an MSI deployment as 
described in the Revu Enterprise Deployment Guide, or you can manually configure individual machines by 
following the steps listed below: 

Note: Centralized PC3 files can only be used for the AutoCAD plugin if the Heidi driver is selected. Centralized 
PC3 files cannot be used for the Bluebeam PDF printer.

If this is distributed as part of an MSI deployment, the client machine must be restarted before it can be used.

 Open Bluebeam Administrator and go to the Net Config tab.
 Click the  located to the right of default folder path for the Heidi Driver.
 When the Windows Explorer dialog opens, locate and click on the network folder which contains 

the PC3 files, and then click Select Folder.
 When the Copy all Bluebeam PC3 Files dialog opens, click No Copy.
 Click Apply and OK.

http://support.bluebeam.com/articles/creating-custom-page-sizes-for-autocad/
http://support.bluebeam.com/help/
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Affected Registry Keys
The following seven registry keys are altered when the PDF Printer pages sizes and PC3 files are centralized:

Note: The folder paths shown below are for demonstration purposes only.

[HKEY_CURRENT_USER\Software\Bluebeam Software\<RevuVersion>\Brewery\V45]

"PageSizeConfigFile"="U:\\netconfig\\PtrPageSizes\\"

[HKEY_CURRENT_USER\Software\Bluebeam Software\<RevuVersion>\Pushbutton PDF\AutoCAD]

"PC3Path"="U:\\netconfig\\PC3"
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Revu Preferences and Settings
The Preferences dialog is used for customizing Revu settings that will 
be used by a single workstation or deployed across your organization. 
The Revu Manual covers these settings and preferences in greater 
detail, but we’re going to cover common options you’ll be asked to 
configure for your end users.

The Revu Preferences dialog can be opened using the keyboard 
shortcut Ctrl+K or by clicking Settings  > Preferences  in the 
upper-right of the Revu interface.

File Access
In addition to other features, the File Access tab is where you can setup and configure our Document 
Management Systems integration to work with Bentley ProjectWise and Microsoft SharePoint, so users can 
directly open, save, and check file in and out using the Revu Document Management System Interface.

Note: ProjectWise Explorer must be installed on the workstation for correct ProjectWise integration.

Quick Launch should not be enabled on machines where the Document Management System Interface has 
been configured to work with ProjectWise because the feature will not let Revu establish a connection to the 
relevant ProjectWise site.

Toolbar Integration Only
When this option is enabled on a workstation, a user will use the Revu 
Document Management Toolbar to access files in Studio Projects, a 
configured Document Management System (DMS), and their local drives.

Studio Preferences
The Studio Preferences determine the appearance and overall user experience within Studio Sessions and 
Projects. All of the options are explained in detail within the Revu Manual, but we’re going to focus on the 
Manage Servers options.  

Manage Servers
If your organization uses Bluebeam Studio Enterprise to host their 
Sessions and Projects, you’ll need to click Manage Servers and enter 
the Bluebeam Studio URL and the user’s account credentials.

The Studio URL and type of account credentials are based on how 
Studio Enterprise was originally installed and configured, as described 
in the Studio Enterprise Installation & Configuration Guide.

Note: Your end users will not be able to connect to your Studio 
Enterprise instance unless this is done.

Please refer to our FAQ on Studio Whitelists for additional information about controlling Studio server access.

Exporting Revu Preferences
If you’d like to use a particular set of Revu Preferences across all or part of your organization, you can click 
Export in the lower left or the Preferences dialog, and save them to a network share. The resulting 
RevuPrefences.xml can be distributed as described in the Revu Enterprise Installation Guide.

http://support.bluebeam.com/help/
http://support.bluebeam.com/online-help/revu2016-1/Default.htm
http://support.bluebeam.com/online-help/revu2016/Content/RevuHelp/11%2520-%2520Preferences/File%2520Access%2520Preferences%2520-%2520M%2520V.htm
http://support.bluebeam.com/online-help/revu2016/Content/RevuHelp/11%2520-%2520Preferences/File%2520Access%2520-%2520Configuring%2520a%2520DMS%2520-%2520V.htm
http://support.bluebeam.com/online-help/revu2016/Content/RevuHelp/11%2520-%2520Preferences/File%2520Access%2520-%2520Configuring%2520a%2520DMS%2520-%2520V.htm
http://support.bluebeam.com/online-help/revu2016/Default.htm
http://support.bluebeam.com/online-help/revu2016-1/Default.htm
http://support.bluebeam.com/online-help/revu2016-1/Default.htm
http://support.bluebeam.com/online-help/revu2016-1/Default.htm
http://www.bluebeam.com/us/products/studio-enterprise/
http://support.bluebeam.com/help/
http://studioenterprisesupport.bluebeam.com/articles/studio-whitelist/
http://support.bluebeam.com/help/
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Revu Profiles
Profiles contain information about the overall layout of the Revu interface, such as toolbar positions, Tool 
Chest contents, and panel configurations.

Exporting Profiles
Complete instruction for managing and exporting Revu Profiles can be found in the Revu Manual, but once a 
Profile is created, configured, and saved, it can be exported to a central location by clicking Export in the 
lower-left of the Manage Profiles dialog. After this in can be deployed as described in the Revu Enterprise 
Installation Guide.

The exported Profile can also be imported into a Revu installation by navigating to its location and double-
clicking the .bpx file.  Alternatively, a profile can be imported by clicking Import in the lower-left of the Manage 
Profiles dialog, navigating to its location, selecting it and clicking Open.

Include Dependencies:
Clicking this checkbox before clicking Export embeds the following items into the Profile:

 Tool Sets
 Hatch Patterns
 Line Styles
 Custom Columns
 Custom Statuses 
 Bookmark Structures™ (Revu eXtreme only)

Using Shared Profiles on a Network Location
If you don’t want to import a profile into Revu, you have the option of “linking” to its location on a centralized 
network location which is accessible to all users who have adequate folder permissions. To do this:

 Open the Manage Profiles dialog and click the Browse  button located to the left of the folder 
path displayed in the Location box.

 Navigate to the folder, click it, and then click Select Folder.

Users who go offline can continue to use the profile, but updates and some shared elements of other profiles 
(notably, some tool sets) will not be available until they go back online.

Note: Shared Profiles are read-only. Any changes made by a user such as, turning a toolbar on or off will be 
lost when Revu is closed.

Read-Only Profiles
By default, Revu remembers the last known state or layout the user interface when the application is closed. 
When a user makes changes, such as enabling a tool bar or hiding the Properties tab, they are saved to the 
active Profile. If your organization uses shared Profiles as described above, you will want to prevent this 
because it overwrites the Profile, which can adversely affect other people who are using it. To do this:

 Navigate to the network location of the Profile.
 Right-click on it, and select Properties in the pop-up menu.
 Click the Read Only checkbox, and then click Apply and OK.

http://support.bluebeam.com/online-help/revu2017/Default.htm
http://support.bluebeam.com/articles/customizing-revu-part-1-introduction/
http://support.bluebeam.com/online-help/revu2017/Default.htm
http://support.bluebeam.com/help/
http://support.bluebeam.com/help/
http://support.bluebeam.com/online-help/revu2017/Default.htm
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The Tool Chest
More in-depth information about the Tool Chest can also be found in the Revu Manual, but essentially it’s a 
convenient location where users can find the Tool Sets used for marking up PDF documents in Revu.

Managing Tool Sets
All tool sets are saved as .btx files that can be copied to a network drive or sent directly to users. As with 
Profiles, Tools Sets can be imported directly in Revu by double-click a .btx file, or from within Manage Tool 
Sets dialog.

To export a Tool Set open the Manage Tool Sets dialog, select the Tool Set and click Export. When the Save 
As dialog opens, navigate to the destination folder you want to export it to, and click save. If your users will be 
sharing this Tool Set, you’ll need to save it to a network location they can access. 

You can also distribute Tool Sets using a command line script as described in the Revu Enterprise Installation 
Guide.

Using Shared Tool Sets on a Network Location
If your users will be sharing a standardized Toolset, you can “link” its location in network location to which they 
have adequate folder permissions. To do this you’ll need to follow the steps listed below for adding an 
existing Tool set:

 Open the Tool Chest tab, and then click Manage Tool Sets icon located in the Tool Chest Toolbar.
 When the Manage Tool Sets dialog opens, click Add. This opens the Add Tool Set dialog.
 In the Type section, select Existing.
 Click the Browse  button located to the right of the Path text box. An Open dialog appears.
 Navigate to the corresponding .btx file, select it, and then click Open. You will be taken back to 

the Add Tool Set dialog.
 To ensure that the Tool Set appears in the Tool Chest, click the Display checkbox located in the 

Options section.
 If you want to make it available to every Revu Profile on the machine, click the Show in All Profiles 

checkbox.
 To store the location to the tool set relative to the location of the current Profile, select Relative 

Path. Uncheck this option to save the full folder path to the Tool Set.

Refer to the Revu Manual for more information about the differences between Relative and Full 
folder paths.

 Click OK.
Note: Although Tool Sets located in shared network location can be used while a user is offline, they cannot be 
updated or checked out.

Locked Tool Sets
A shared Tool Set in a network location will always be in a locked state by default, to prevent edits by more 
than one user at a time. To signify this, the Tool Set in question will appear in the Tool Chest with a blue 
padlock located to the right of its name.

As the Administrator, you can grant any team member the permissions required to update a Toolset, but a 
user can also request permissions by clicking the padlock icon.  Once they have permissions the icon will 
change to a checkmark. Changes made to a Tool Set affect all users sharing it.

http://support.bluebeam.com/online-help/revu2017/Default.htm
http://support.bluebeam.com/online-help/revu2017/Default.htm
http://support.bluebeam.com/online-help/revu2017/Default.htm
http://support.bluebeam.com/help/
http://support.bluebeam.com/help/
http://support.bluebeam.com/online-help/revu2017/Default.htm
http://support.bluebeam.com/online-help/revu2017/Default.htm
http://support.bluebeam.com/online-help/revu2017/Default.htm
http://support.bluebeam.com/online-help/revu2017/Default.htm
http://support.bluebeam.com/online-help/revu2017/Default.htm
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Read-Only Tool Sets
If you want to prevent changes to a shared Tool Set you can set its properties to read-only by doing the 
following:

 Navigate to the network location of the Tool Set.
 Right-click on it, and select Properties in the pop-up menu.
 Click the Read Only checkbox, and then click Apply and OK.

Hatch Patterns
Revu includes several standard Hatch Patterns used for filling in markups, which can be exported, imported, or 
added in the same manner as Tool Sets. Along with this, these Hatch Pattern (.bhx) files can also be exported 
to a centralized network location from where they can be deployed to your Revu installation. 

You can find details about deploying Hatch Patterns within your organization in the Revu Enterprise Installation 
Guide. Information about managing exporting, importing, adding, or otherwise working with your hatch 
patterns can be found in the Revu Manual.

SharePoint® and ProjectWise® Integration
Revu has direct integration into Microsoft SharePoint and Bentley ProjectWise and document management 
systems (DMS). You can check-In, checkout and view files from either a ProjectWise DataSource or SharePoint 
Document Library directly from within the Revu interface.

Logging In
By default, whenever you login to a SharePoint site, the first login attempt will use your Windows account 
credentials. If attempt fails, you will be prompted to enter credentials. To ensure as smooth authentication, 
Revu can store the correct credentials for you within the Revu File Access Preferences, however these 
credentials will not be included when the RevuPreferences.xml file is exported.

The Revu Manual includes more in-depth information about setting up SharePoint or ProjectWise integration, 
but the basic steps are:

 Click Settings  > Preferences (Ctrl+K), and select File Access from the Preference list on the left 
side of the Preferences dialog.

 Click Add in the lower-right of the Preferences dialog. This opens the Add Document 
Management Systems dialog.

 Select the Type of DMS you’re trying to configure access to and then enter the login credential 
and any other required information.

 Click ok to close the dialog windows.

http://support.bluebeam.com/help/
http://support.bluebeam.com/help/
http://support.bluebeam.com/online-help/revu2017/Default.htm
http://support.bluebeam.com/online-help/revu2017/Default.htm
http://support.bluebeam.com/online-help/revu2017/Content/RevuHelp/11--Preferences/File-Access-Configuring-DMS--V.htm
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Electronic and Digital Signatures
Before we get into the specifics of working with and troubleshooting Electronic and Digital Signature, let’s 
take a look at the differences between the two.

Electronic Signatures
An Electronic Signature is any digital representation (image) of the signer's 
signature and intent to sign. They can take many forms, such as an image of 
the signer’s paper signature, a PDF markup containing an image of the signer’s 
signature, a PDF stamp with a signer’s name and current date, or even a 
checkbox that can be clicked to agree to terms. Electronic Signatures are legally equivalent to traditional 
paper signatures (E-SIGN Act Public Law No. 106-229).  For more information see ESIGN or The American 
Institute of Architects best practice.

Because they are legally binding, Electronic Signatures, as described here, can satisfy a wide range of needs 
within the AEC industry, and are well-suited for documents that will see regular use by multiple parties after 
signing. For example, in the case of drawing sheets signed before issuance to a contractor, signing with an 
Electronic Signature such as a dated PDF stamp or markup, instead of a Digital Signature, preserves the 
recipient’s ability to make crucial enhancements to the document’s usability, such as slip-sheeting or adding 
pages, without invalidating the signatures present. Bluebeam Revu offers the Flatten feature to secure 
markups and stamps by embedding them into the PDF content, ensuring that markups representing 
signatures cannot be easily removed or modified.

Note: Since Electronic Signatures are not the same as Digital Signatures backed by a trusted source, Electronic 
Signatures do not have any security associated with them. Electronic Signatures are basically just an image of a 
person’s wet signature.

Digital Signatures
A Digital Signature is a specific type of electronic signature technology 
intended to guarantee the authenticity of the signer and the integrity of the 
document. Digital Signatures independently validate the signer’s authenticity 
through a trusted certificate that is shared between parties, or through a third-
party Certificate Authority (CA) that issues a Digital ID on behalf of the signer. 
(CA examples include: GlobalSign, IdenTrust, and Entrust.) These protocols are intended to protect a 
document’s integrity by preventing any future content-level changes.

Digital Signature technology is most suitable for finalized legal documents and contracts with archival intent. It 
is important to note that Digital Signature technology, when applied to PDFs, will block certain document 
content-level edits, such as adding/deleting pages or flattening markups that are critical to the downstream 
consumption of drawing sheets and other regularly referenced project PDFs. Non-content-level edits are still 
allowed, such as adding new Digital Signatures and markups, as well as filling out form fields.

https://www.gpo.gov/fdsys/pkg/PLAW-106publ229/pdf/PLAW-106publ229.pdf
http://www.aia.org/practicing/bestpractices/AIAS077006
http://www.aia.org/practicing/bestpractices/AIAS077006
http://support.bluebeam.com/articles/how-do-i-add-an-image-of-my-signature-to-a-pdf/
http://support.bluebeam.com/articles/how-do-i-add-an-image-of-my-signature-to-a-pdf/
https://www.identrust.com/bluebeam/index.html
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Digital Signature Enforcement

Revu 2015.5 and Above
To address specific legacy workflows, an option within the Revu Preferences allows content edits to invalidate 
Digital Signatures instead of restricting those edits.

Revu 2015.0 to 2015.1.1
To minimize unintentional invalidation, edits to PDF content are prevented on documents with Digital 
Signatures, although adding new signatures, filling out form fields, and adding markups are still allowed.

Revu 12 and Below
Edits to PDF content were allowed on Digital Signature documents, but signatures were displayed as invalid.

Signature Preferences
Digital Signatures typically restrict changes to signed documents, and 
are invalidated if alterations are made to the file. However in Revu 
2015.5 and above, the Signature Preferences gives you the option of 
disabling function by clearing the “Restrict changes to documents…” 
checkbox.

Note: Although clearing this checkbox doesn’t invalidate signatures, it 
will enable the tools to make changes that will.

Troubleshooting Digital Signatures
Issues with digital signatures are usually centered on the Security Hash 
Algorithm used by the signature, or validation of the signature itself and the corresponding Certificate.

Signature Algorithm
By default the Security Hash Algorithm used when applying Digital Signatures is SHA-256. If a user is unable to 
sign because their signature uses an older digital ID, you should switch the Algorithm to SHA-1.

Signature Not Validated Error 
A green question mark next to a signature means the signer’s identity 
is unknown, and their Digital Certificate needs to be imported into the 
Revu Trusted Identity Store or the Windows Certificate Store. Once 
the certificate has been successfully imported and validated, a green 
checkmark  will be seen next to the signature.

We’ve included instructions for importing and validating Digital 
Certificates in the following sections as well as the Revu manual, but 
it’s really important that you know and trust the person who sent the 
certificate. This is because once a certificate is imported, Revu will 
trust every signed document you receive from that person in the future.

Note: The best practice would be to have the signer send you their certificate ahead of time, so it can be 
installed before you receive the first document.

http://support.bluebeam.com/online-help/revu2016-1/Default.htm
http://support.bluebeam.com/help/
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Importing Digital Signature Certificates
You can find more information about working with Digital signatures and Certificates in the Revu manual, but 
we’ll provide the essential steps for importing a certificate into either the Revu Trusted Certificate Store or 
Windows Certificate Store here.

Importing into the Revu Trusted Certificate Store
To import a digital ID certificate from a file you've been sent:

  Save the .cer file you’ve received to your local drive or network.
 Open any PDF in Revu, and click Document > Signatures – 

Trusted Identities. This opens the Manage Trusted Identities 
dialog.

 Click Add Trusted Identities +.
 Locate and click on the .cer file you saved, and click Open. The 

certificate is added to the list of trusted identities.
 Validate the Digital Signature by following the instructions listed 

below.

Importing into the Windows Certificate Store
In most cases, you’ll import a certificate into either the Trusted People Store or the Trusted Root Certification 
Authorities store. If the certificate was self-signed by an individual you’ll need to import it into the Trusted 
People Store. On the other hand, it will need to go into the Trusted Root Certification Store if it was issued by 
a Root Certificate Authority (CA) certificate, such as Entrust, GlobalSign or IdenTrust.

To do this:

 Open the signed document in Revu.
 Open the Certificate dialog either by: 

Right-clicking the signature on the page and clicking Properties
-Or-
Open the Signatures  tab, and click the settings  icon located to the 
right of the signature when you hover it.

 Click Install Certificate and follow the prompts to install the certificate 
into the appropriate Windows Certificate Store.

Self-signed Certificates are imported into the Trusted People store. 

Certificates issued by a Root Certificate Authority are imported into the 
Trusted Root Certificate Authorities store.

http://support.bluebeam.com/online-help/revu2016-1/Default.htm
http://support.bluebeam.com/help/
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Validating a Digital Signature
To validate a Digital signature:

1. Open the document in Revu, and right-click the signature on the 
page.

2. Click Validate Signature.
The signature icon will now include a green checkmark  indicating that the 
signature is valid.

Accessing the Windows Certificate Store
If you want to confirm that a certificate has been 
imported correctly you can open the Windows 
Certificate Store by clicking the Windows Start button 
and typing certmgr.msc in the search.
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